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Handout 1 
 

The Suggested Enrichment Program Outcomes 
 

Dear student, 
 
The following are the suggested enrichment program outcomes. Please, read 
them before receiving instruction: 
 
Through the suggested enrichment program you will hopefully be able to use 
Cinderella to: 
 
Outcome 1 Construct dynamic figures. 

Outcome 2 Come up with many construction methods to construct dynamic 
configurations for a certain figure. 

Outcome 3 Come up with many different and varied construction methods 
to construct dynamic configurations for a certain figure. 

Outcome 4 Come up with novel and unusual methods to construct dynamic 
configurations for a certain figure. 

Outcome 5 Produce many relevant responses (ideas, solutions, proofs, 
conjectures, and new formulated problems) toward a geometric 
problem or situation. 

Outcome 6 Produce many different and varied relevant responses (ideas, 
solutions, proofs, conjectures, new formulated problems) toward 
a geometric problem or situation. 

Outcome 7 Generate many unusual ("way out"), unique, clever responses or 
products toward a geometric problem or situation. 

Outcome 8 Make new conjectures and relationships by recognizing your 
experience toward the aspects of the given problem or situation. 

Outcome 9 Investigate the made conjectures and relationships in different 
situations and methods.  

Outcome 10 Generate many different and varied proofs toward a geometric 
problem or situation.  

Outcome 11 Generate many follow-up problems by redefining (modifying, 
adapting, expanding, or altering) a given geometric problem or 
situation. 

Outcome 12 Apply different learning aspects of geometry (concepts, 
generalizations, and skills) in solving a geometric problem or 
situation.  



Handout 2 
 

Launching and Exploring Cinderella 
 

In this session you will learn how to: 
 

 Launch Cinderella 
 Explore Cinderella window 
 Explore Cinderella menus 

 
Student Activity: Launch Cinderella 
 
To start Cinderella, It depends on where Cinderella installing folder is; however 
you may either: 
 

 Double-click Cinderella.2 shortcut on the desktop, If it exists. 
 

 
 

 Click Start button on the taskbar. 
Click Programs. 
Find and click Cinderella. 2 
 

 



 Double-click a file created by Cinderella. Files that are created by 
Cinderella usually have the extension “.cdy” and have icons similar to 
the icon shown below. 

 
 
After a few moments, Cinderella will launch and be ready to work. 
 
Exploring Cinderella Window 
  
After you launch Cinderella, you will see a window, called “Unnamed in 
(Euclidean View)”. It looks similar to the figure shown below. The main window 
of Cinderella consists of seven major elements. Here are the main elements of 
the window in order from the top to the bottom. 
 

 
 

Figure shows a Cinderella window. 
 
1. Title Bar 

 
Here you will find the name of the program – Cinderella – and the 
current construction file name and its corresponding view as well. If you 
haven’t named the construction file yet, you will see something like 
“Unnamed in (Euclidean View)”.  
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2. Menu Bar 
 

It contains the menus with the commands that control Cinderella. It 
comprises of seven menus, which are: File, Edit, Modes, Geometry, 
Views, Format, and Help. Click on a menu to pull it down. Select a 
command by clicking on it. 
 

3. Standard Toolbar 
 

It contains buttons for basic/general commands such as opening, saving, 
printing, exporting, undoing, redoing, and selecting.  
 

4. Geometric Modes Toolbar 
 

This toolbar contains tools for all geometric construction modes ranging 
from adding point to generating loci. 
 

5. Construction Area 
 

This is the area where you can create and modify your geometric 
constructions such as points, straight lines, and circles. Here, you can 
also make your geometric explorations using Move mode. 
 

6. Specific-view Actions Toolbar 
 

This toolbar contains buttons for specific-view actions such as zooming 
in and out, translating, drawing coordinates axes, drawing rectangular 
or triangular grids, and showing hidden elements. 
 

7. Message Bar 
 

In this bar Cinderella tells you in which mode you are and what actions 
you should do.   

 
Exploring Cinderella Menus 
 
Cinderella menu bar comprises of 7 pull-down menus, which are: File, Edit, 
Modes, Geometry, Views, Format, and Help respectively. It should be 
mentioned here that all functions and facilities of Cinderella could be accessed 
through the main menus, whereas the toolbars only include the most important 
tools. 
 



1. File Menu 
 

The File menu contains a list of file-related 
commands, such as New, which creates a 
new Cinderella file, Open which opens or 
loads a Cinderella saved file, Save which 
saves the current Cinderella file, Close 
Window which closes the current 
Cinderella file, etc.  Notice the 
combination next to some of the 
commands in the file menu. For instance, if 
you want to save a Cinderella file use the 
combination Ctrl+S (Control key and S 
key). 
 

 
 

2. Edit Menu 
 

This menu contains tools for undoing, 
redoing, and copying and pasting parts of 
construction. In addition, under this menu 
you can create Macro-constructions using 
the tool, Create Tool from Selection.  It 
also contains several tools for selection that 
enables you either to select all, select 
points, select lines, select conics, or 
deselect all. Here you also get access to 
the inspector, a tool that can be used to 
edit the geometric elements within your construction. 

 
 
 

3. Modes Menu 
 

The Modes menu contains a 
collection of construction tools 
for all geometric constructions 
ranging from adding point to 
generating loci. Most of these 
tools can be accessed via 
geometric modes toolbar. 

 
 
 
 



4. Geometry Menu 
 

One of the main features of Cinderella is that it 
supports different kinds of geometries. Here you 
can choose the kind of geometry you wish to work in (the default is 
Euclidean Geometry, but you can also work in hyperbolic geometry or 
elliptic geometry). It should be mentioned here that switching to another 
kind of geometry does affect the behavior of the geometric elements you 
will construct. 

 
 
 

5. Views Menu 
 

This menu enables you to open your 
constructions in different views (the 
default is Euclidean View, but you can 
also open your construction in 
Hyperbolic View, Spherical View, Polar 
Euclidean View, and Polar Spherical 
View). It also enables you to open the 
Construction Text (Cinderella special 
window that shows a detailed description for each element within your 
construction) as well as the Information Window that shows and reports 
non-trivial facts about your construction. 

 
 
 

6. Format Menu 
 

The Format menu enables you to choose the 
default format in which units and equations 
should be displayed. 

 
 
 
 

7. Help Menu. 
 

The Help menu contains Help on mode 
that provides help for the current mode, 
Cinderella complete Manual, and 
references to online help, updates and 
licensing issues.  
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Basic Commands and Constructions (Modes) of 
Cinderella 

 
In this session you will learn about: 
 

 Cinderella basic commands  
 Cinderella basic constructions (modes) 

 
Cinderella Basic Commands 
 
Open New Cinderella Window 
 
To get a new construction window in Cinderella, do one of the following: 
 

 From the File menu select New. 
 Press the keyboard shortcut Ctrl+N. 

 Click on the new button  on the standard toolbar. 
 
The New command opens a new, blank Cinderella window in Euclidean View 
for creating and modifying geometric constructions. In this new window, 
everything is reset to the default state. 
 
Open/Load Cinderella Saved File 
 
To open/load a Cinderella saved file, do one of the following: 
 

 From File menu select Open. 
 Press the keyboard shortcut Ctrl+O. 

 Click on Open button  on the standard toolbar. 

 Double-click the Cinderella file icon; it could be similar to this icon . 
 
The open command opens a dialog box for opening an existing Cinderella file. 
 
Save Construction 
 
To save the current construction, do one of the following: 
 

 From File menu, select Save. 
 Press the keyboard shortcut Ctrl+S. 

 Click on Save button  on the standard toolbar. 
 



The save command opens a dialog box that allow you to save the current 
Cinderella construction to a name that you specify. 
 
Save Construction with New Name 
 
To save the current construction with a new name, do one of the following: 
 

 From File menu select Save as. 
 Press the keyboard shortcut Ctrl+Shift+S. 

 Click on Save as button  on the standard toolbar. 
 
The save as command opens a dialog box that allows you to save the current 
Cinderella construction to another name that you specify. 
 
Create an Interactive Web Page 
 
To create an interactive web page of the current construction, do one of the 
following: 
 

 From File menu select Export to HTML. 
 Press the keyboard shortcut Ctrl+E. 

 Click on Create an Interactive Web Page button  on the standard 
toolbar. 

 
This action will open a dialog box that allows you to save the current Cinderella 
file as a web page. 
 
Two warnings should be taken into consideration, while you are creating 
interactive web pages: 
 

(1) The construction data has to be saved as Cinderella file with the 
extension “cdy” before you export it to HTML. 

 
(2) The construction data has to be saved into the same directory your 

webpage will be resided in. 
 

Undo  
 
Undo command enables you to take one or more actions backward. You can 
undo as many backward actions as you want; however each click on the undo 
button takes you one action backward.  The undoable actions are: 
 

 Construction steps 
 Movements 
 Appearance changes 
 Zooming, translating, and rotating views 



 Deletion of elements 
 
Redo  
 
Redo command enables you to take one or more actions forward. Here you can 
also redo as many forward actions as you want. 
 

Delete   
 
Delete command is used to delete currently selected elements and other 
elements that depend on them. 
 
Selection Commands 
 
Under the Edit menu, there are several tools for selection that enable you either 
to select all elements, all points, all lines, or all conics and circles. All of these 
tools are also accessible via corresponding buttons on the standard toolbar. 
 

Select All Elements  
 
It is used to select all geometric elements in the construction. 
 

Select All Points  
 
It is used to select all points in the construction. 
 

Select All Lines  
 
It is used to select all lines in the construction. 
 

Select All Conics  
 
It is used to select all conics and circle in the construction. 
 

Deselect Everything  
 
It is used to clear the current selection in the construction. 
 



Cinderella Basic Constructions (Modes) 
 

Move Mode  
 
The move mode is one of the most important tools that provide Cinderella with 
the dynamic behavior – the ability to move free elements and the whole 
constructions moves accordingly without destroying the configuration which is 
a very beneficial characteristic in exploring geometric relationships. 
 
Generally, move mode has twofold functions that enable you to select and 
move elements around the construction area. 
There are two types of points: free/movable points and fixed points.  
 
Free points: these are not dependent on the elements of the construction and 
can be moved around the construction area freely and the rest of the 
construction moves/changes accordingly. 
 
Fixed points: are points that are dependent on the position of other free 
elements of the construction and cannot be moved. 
 
In the construction area, you can visually distinguish between the free and fixed 
points by their appearance: fixed points appear darker. 
 
Moving Points 
 
To move a free/movable point, move the mouse pointer over the point you want 
to move. Press the left mouse button. Hold it pressed and drag the mouse. The 
point follows the mouse pointer.   
 
Selecting Elements 
 
The move mode can also be used to select one or more geometric elements in 
the construction area. To select an element, just click over the element you 
want to select. By holding the shift key you can select several elements at the 
same time. 
 
You can easily recognize the selected elements, since they are highlighted in all 
views. You may select elements for the following reasons: 
 

 To individualize the appearance of geometric elements using the 
inspector which is available under the item menu “Edit/Information”. 

 
 To delete the selected elements using “Delete” action. 

 
 To simultaneously move the selected elements. 

  



Add a Point  
 
Add a point mode construct a single new point by using a single press-drag-
release sequence mouse input. Constructing a point can be described as 
follows: 
 

 Pressing the left mouse button generates the point. 
 

 Dragging the mouse while the left mouse button is pressed changes the 
position and definition of the point. 

 
 Releasing the mouse button fixes the definition of the point.  

 
The definition of the point depends on the position on which the mouse was 
released. In other words, if at the moment of release the mouse is … 
 

 … over no element at all, then a free point is added and can 
be freely moved in “Move Mode”. 

 
 … over an existing element (line, circle, conic), then a semi 

free point is added on the existing element and can be moved 
along the existing element in “Move Mode”. 

 
 … over the intersection of two elements (line, circle, conic) 

,then the intersection of these elements is added as a fixed 
point that can not be moved in “Move Mode”. 

 
 … over an existing point, then no point will be added. 

 
 

Add a Line  
 
Add a line constructs two points and a straight line joining them by using a 
single press-drag-release sequence mouse input. Constructing two points and a 
line joining them can be described as follows: 
 

 Pressing the left mouse button generates the first point. The definition of 
this point depends on the position of the mouse when the button is 
pressed as explained earlier in “Add a Point”. 

 
 Dragging the mouse while the left mouse button is pressed generates the 

line and the second point. The definition of the second also depends on 
the position of the mouse. 

 
 Releasing the mouse button freezes the second point and ends up with 

the straight line that joins the two points. 
 



Line through Point  
 
Line through point mode constructs a line through a point with a certain slope 
so that when the point is moved, the slope of the line remains constant. 
However, in move mode it is also possible to select the line and change its 
slope. Constructing line through point can be described as follows: 
 

 Pressing the left mouse button generates the point.  
 

 Dragging the mouse while the left mouse button is pressed generates the 
line.  

 
 Releasing the mouse button freezes and finishes the construction. 

 

Add a Parallel  
 
Add a parallel mode constructs a line through a point parallel to another line by 
using a single press-drag-release sequence mouse input. Constructing the 
parallel can be described as follows: 
 

 Move the mouse pointer over the line you want to construct a parallel to 
it. Then press the left mouse button. This action generates the parallel 
line and a point, which the parallel line passes through it. 

 
 Drag the mouse while the left mouse button is pressed. This action 

moves the parallel line and the generated point to the desired position. 
 

 Release the mouse button. This action freezes the definition of the 
parallel line and the new point, and finishes the construction.  

 

Add a Perpendicular  
 
Add a perpendicular constructs a line through a point perpendicular to another 
line by a single press-drag-release sequence using the mouse. Constructing the 
perpendicular can be described as follows: 
 

  Move the mouse pointer over the line you want to construct a 
perpendicular to it. Then press the left mouse button. This action 
generates the perpendicular line and a point, which the perpendicular 
line passes through it. 

 
 Drag the mouse while the left mouse button is pressed. This action 

moves the perpendicular line and the generated point to the desired 
position. 

 



 Release the mouse button. This action freezes the definition of the 
perpendicular line and the new point, and finishes the construction. 

 

Add a Circle  
 
Add a circle mode constructs a circle given by its center and a point on its 
circumference by using a single press-drag-release sequence mouse input. 
Constructing a circle in this mode can be described as follows: 
 

 Pressing the left mouse button generates the center of the circle. 
 

 Dragging the mouse while the left mouse button is pressed generates the 
circle and the circumference point. 

 
 
 Releasing the mouse button freezes the definition of the circumference 

point and finishes the construction. 
 

Midpoint  
 
Midpoint mode constructs two points and the point that is the midway between 
them using a single press-drag-release sequence with the mouse. Constructing 
the midpoint can be described as follows: 
 

 Pressing the left mouse button generates the first point. 
 

 Dragging the mouse generates the second point and the midpoint as 
well. 

 
 Releasing the mouse freezes the definition and finishes the construction. 

 

Segment  
 
Segment mode constructs two points and a line segment joining them by using a 
single press-drag-release sequence mouse input. Constructing two points and a 
line segment joining them can be described as follows: 
 

 Pressing the left mouse button generates the first point. 
 

 Dragging the mouse while the left mouse button is pressed generates the 
second point and the line segment joining the two points. The definition 
of the second also depends on the position of the mouse. 

 
 Releasing the mouse freezes the second point and ends up with the line 

segment line that joins the two points. 



Student Activity: 
 
Use Cinderella to come up with dynamic configurations for each of the 
following figures: 
 

 Triangle  
 Equilateral triangle  
 Isosceles triangle  
 Right-angled triangle 

 
 Quadrilateral 
 Trapezium  
 Parallelogram 
 Rectangle 
 Rhombus 
 Square 

 
 Circle 
 Tangent to a Circle 
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Dragging and Measuring Facilities of Cinderella 
 

Cinderella has a wide range of facilities; among these facilities are the dragging 
and measuring facilities. In this activity, you will experience the dragging and 
measuring facilities of Cinderella to make and investigate new geometric 
conjectures. 
 
Student Activity: 
 

1. Launch Cinderella or open new Cinderella file. 
 

2. Use Cinderella to construct any triangle. (Use “Add Point” tool  to 
construct three points A, B, and C as three vertices of the triangle, then 

switch to “Draw a Segment” tool  to join up the three points using a 
press-drag-release sequence with the mouse to end up with triangle ABC) 

 
3. Construct the midpoints of the sides of the triangle. (Use “Midpoint” tool 

 with the mouse press-drag-release sequences to bisect the three sides 

! 

AB, 

! 

BC , and 

! 

AC  at D, E, and F respectively) 
 

4. Join the midpoints of the sides to get the four triangles: △ADF, △DBE, 

△EDF, and △CEF. (Use “Draw a Segment” tool  to join the 
midpoints D, E, and F). Your construction should look like the figure 
shown below before you continue. 

 

 
 

5. Switch to “Move” mode by pressing the button  in the toolbar. Use 
Cinderella’s dragging facility to drag free points (A, B, or C), visually 
observe the four triangles and try to make a conjecture about the area of 
the four triangles. In other words, what can you say about the area of the 
four triangles? 

 



6. Using measuring facilities of Cinderella, the area of each triangle can be 
measured. For doing so, switch to the “Define a Polygon” mode by 

pressing the button  in the toolbar, define the four triangles as 
polygons: Poly0, Poly1, Poly2, and Poly3, then switch to the “Measure 

Area of a Polygon” mode by pressing the button  in the toolbar and 
just click inside each triangle (polygon) to get its area.  

 
7. Use dragging to alter the triangle △ ABC and visually observe the area 

of the four triangles. What can you conclude about the area of the four 
triangles obtained by joining the midpoints of the sides of a triangle? 
Write down your conjecture in the form of mathematical theorems. 

 
8. Produce a mathematical proof for the investigated conjecture. 

 
9. Pose follow-up problems related to this geometric situation.  
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Automatic Proving Facilities of Cinderella 
 

Cinderella has built-in automatic proving facilities that could be used to 
immediately check the correctness of your geometric conjectures. In this 
activity, you will see how to use these facilities to check the collinearity of the 
three points. 
 
Student Activity: 
 

1. Launch Cinderella or open new Cinderella window. 
 

2. Switch to “Circle by Radius” mode using “Modes” menu or by pressing 
the button  in the toolbar. 

 
3. Move the mouse pointer over the construction area. Use a press-drag-

release sequence with the mouse to add a circle with centre A. 
 

 
 
4. Add a second circle using the same mode such that the two circles 

intersect. 
 

 
 

5. Generate the intersection points between the two circles, for doing so, 
switch to “Intersection” mode by pressing the button  in the toolbar, 
then select the two circles one at a time to generate their intersection 
points C and D. Your construction should look like the following figure 
before you continue. 

 



 
 

6. Switch to “line by two points” mode by choosing the menu item 
“Modes/line/by two points”, by pressing the keyboard shortcut “Ctrl+L”, 
or by pressing the button  in the toolbar. Use a press-drag-release 
sequence with the mouse to add a line connecting the two points A and 
D. 

 
7. Add another line connecting the two points D and B. 

 

8. Switch to “Intersection” mode by pressing the button  in the toolbar. 
Select Circle A and Line a to get the intersection point E. 

 
9. Using the same mode, select Circle B and Line b to get the intersection 

point F. 
 

10.  Open “Cinderella’s inspector” by choosing the menu item 
“Edit/Information”. 

 

11. Select all lines by pressing the button . 
 

12. Clip the two lines by choosing the clipping button  on the inspector. 
After clipping the two lines to their endpoints your construction should 
look like the following figure. 

 

 
 

13. Use Cinderella’s dragging facility to drag free elements in your 
construction and visually observe the behavior of the three points F, C, 
and E? What can you say about the three points F, C, and E in terms of 
collinearity? i.e. Are they collinear? Anyway make a conjecture about the 
collinearity of the three points and Cinderella will check it for you.  



 
14. To check the correctness of the made conjecture about the collinearity of 

the three points, open Cinderella’s information window by choosing the 
menu item “View/Information Window” or pressing the keyboard 
shortcut “Ctrl+5”. A console window pops up in which an automatic 
report about the configuration will appear. Now, switch to the "Line, by 

two points" mode by pressing the button  to construct the line that 
connects the two points F and E, and then move the mouse pointer 
toward the point F press the left mouse button, hold it then drag the 
mouse over point E then release the mouse button. Notice the message 
that is given in the Cinderella Console Window, which indicates that 
point C lies on the connecting line of F and E. 

 
15.  Produce as many mathematical proofs as possible to prove the 

investigated conjecture.  
 

16. Use different facilities of Cinderella to make up as many new conjectures 
as possible by elaborating – extending, modifying, or adapting – the 
conditions of the given situation. 
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Developing Macro-constructions 
 

Cinderella has the ability to capsulate a sequence of construction commands 
into a new command/tool, which is called Macro-constructions. In this activity, 
you will experience how to use Macro-construction facilities to develop some 
geometric tools such as: perpendicular bisector and circum-center point of a 
triangle. 
 
Student Activity: Developing a macro tool for perpendicular 
bisector. 
 

1. Launch Cinderella or open new Cinderella window. 
 

2. Switch to “Circle by Two Points” mode using “Modes” menu or by 

pressing the button  in the toolbar. This mode allows you to construct 
a circle with two points one at the center and the other at the 
circumference of the circle. 

 
3. Use a press-drag-release sequence with the mouse twice to construct two 

points A and B and two circles that use A and B as centers and B and A 
as point on the circle. 

 

 
 

4. Generate the intersection points between the two circles at C and D, 

using the “Intersection” mode . Then, switch to “Add a Line” mode 
 to construct to the perpendicular bisector of A and B. 

 



 
 

5. To define a macro you have to select the initial elements – here the two 
points A and B – and the final elements – here the line a. So, Switch to 
“Move” mode, and then use Shift key to select the two points A and B 
and the connecting line a. 

 

 
 

6. Now, the three selected elements, the two points A, B and the line a, 
which represent the initial and final elements, can be used to create a 
macro tool for the perpendicular bisector. For doing so, choose menu 
item “Edit/Create Tool from Selection” or press the keyboard shortcut 
“Ctrl+Shift+N”. A new window of two fields pops up that requires a 
name and a description for the new tool. Enter the name and the 
description for the new tool – Perpendicular Bisector and Create the 
Perpendicular Bisector are suggested to be a name and description for 
the new tool – then, click OK button to confirm the creation of the tool. 
The icon is created automatically and will be available in the toolbar.  

 

 
 
 



Student Activity: Developing a macro tool for circum-center point of a 
triangle. 
 
In this activity, you will be guided to use the perpendicular bisector tool to 
construct the circum-center point of a triangle and develop a new macro tool for 
the circum-center point of a triangle as well. 
 

1. In the last Cinderella window that contains the developed perpendicular 
bisector tool. Clean the construction area by selecting all elements using 

the item menu “Edit/Select all” or by clicking the button  or by 
pressing the keyboard shortcut Ctrl+A. Then, delete elements using the 

menu item “Edit/Delete Elements” or by clicking the button  or 
pressing the keyboard shortcut Ctrl+Delete. 

 
2. Construct a triangle ABC.  

 
3. To construct the perpendicular bisectors for the triangle sides, click the 

developed perpendicular bisector tool button  three consecutive 
times this action will instantly paste the points A’ and B’; A” and B”; A3 
and B3 and the perpendicular bisector lines a’, a” and a3. 

  

 
 

4. Switch to “Redefine Point” by using the menu item “ Modes/Redefine 

Point” or by clicking the button  in the toolbar mode and then move 
A’ to A, B to B’, A” to B, B” to C, A3 to A, and B3 to C. That will end up 
with a configuration of a triangle and its side perpendicular bisectors. 

 



 
 

5. Generate the intersection point of the perpendicular bisectors at D1 to get 
the circum-center point of triangle ABC. 

 
6. Switch to “Move” mode, and use Shift key to select the points A, B, C as 

initial elements and D as final element for the macro. 
 

 
 

7. After you select the initial and final elements of the macro, use “Create 
Tool from Selection” command from edit menu to develop a new macro 
tool for the circum-center point of a triangle, and give it a name and a 
description. A new icon for the circum-center point of a triangle will be 
created in the toolbar. 

 

                                                
1 Remark: The perpendicular bisectors of the sides of a triangle are concurrent. The automatic 
proving facilities of Cinderella can be used to show that, while you are generating the 
intersection point D. 



Assignment project: 
 
Use Cinderella to develop a macro tool for each of the following: 
 

 In-center point of a triangle 
 

 Orthocenter point of a triangle 
 

 Center of mass or centroid point of a triangle 
 

 Euler line of a triangle 
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Animating and Tracing Loci Facilities of Cinderella 
 

In this activity, you will experience the use of animating and tracing loci 
facilities of Cinderella to discover and generate geometric loci. 
 
Student Activity:  
 

1. Construct a triangle ABC in a way that it is possible to move the point C 
along a straight line L, which is parallel to the base 

! 

AB. 
 

2. Construct the three heights of the triangle ABC and generate their 
intersection point at D2. Your construction should look like the following 
figure. 

 

 
 

3. Move the point C along the straight line L, which is parallel to 

! 

AB, and 
observe the point D (the heights intersection point). Can you expect the 
locus of the point D, while the point C moves along the straight line L? In 
other words, which curve does the point D trace, while the point C 
moves along the straight line L? Make a conjecture? 

 

4. The locus of the point D can be automatically generated using tracing a 
locus facility of Cinderella. For doing so, switch to “Create a Locus” 
mode by choosing the menu item “Modes/special/loci” or by clicking 

the button  in the toolbar. Afterwards, to generate the locus, three 
objects should be defined: the moving element, which is the point C; the 
road, which is the straight line L; and the tracer, which is the point D (the 
heights’ intersection point). So choose the point C, then the straight line L 
and finally choose the point D. Within a second the locus will be 
automatically generated. After the locus is generated your construction 
should look like the figure shown below. 

 

                                                
2 Remark: The heights of a triangle are concurrent. The automatic proving facilities of Cinderella 
can be used to show that, while you are generating the intersection point D. 



 
 

5.  Switch to “Move” mode and experience the locus when you move the 
point C along the line L. 

 
6. Moreover, Cinderella has powerful animation facilities that can 

automatically move the point C along the line for you, and you do not 
have to move the point by your self. To generate an animation for the 
point C along the straight line L, switch to “Animation” mode by 
choosing the menu item “Modes/Special/Animate” or by clicking the 

button  in the toolbar. Then, two elements should be defined: the 
moving element, which is the point C and the road, which is the straight 
line L. So select the point C then the straight line L. After you have 
defined the animation an animation control panel with three buttons and 
a speed slide pops up in the lower left corner of the window.  

 
7. Use the animation buttons with the speed slide to experience the locus of 

the point D when the point C is automatically moved along the straight 
line L. 

 
8. Use Cinderella to elaborate the given situation by altering its conditions 

to discover and generate other geometric loci related to triangle. 
 

For example: the situation can be elaborated to discover and generate the 
locus of the medians intersection point of a triangle when a triangle vertex 
moves along a straight line. In this case, as shown in the figure below, the 
locus of the medians intersection point is a straight line, which is parallel 
to the road straight line. 
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Midpoints of the Sides of a Quadrilateral  
 

Student Activity:  
 
Use Cinderella to construct any quadrilateral. Construct the midpoints of each 
side. Connect the midpoints of the adjacent sides. 
 
Make a conjecture about the obtained figure. i.e. what is the figure formed by 
joining the midpoints of the adjacent sides of a quadrilateral? 
 
Use Cinderella objects and tools to investigate the conjecture. 
 
State your conjecture in the form of mathematical theorems. 
 
Can you figure out a mathematical proof for this conjecture?  
 
Can you pose some follow-up problems related to the original problem?  
 
 
 
 



Handout 9 
 

Angular Bisectors of a Parallelogram 
 

Student Activity: 
 
Use Cinderella to construct a parallelogram. Construct the angular bisectors of 
the interior angles of the parallelogram. Generate the four intersection points of 
the angular bisectors. 
  
Make a conjecture about the obtained figure. i.e. What is the figure formed by 
joining the four intersection points the angular bisectors of the interior angles of 
parallelogram? 
 
Use Cinderella objects and tools to investigate the conjecture. 
 
State your conjecture in the form of mathematical theorems. 
 
Can you figure out a mathematical proof for this conjecture? 
  
Can you pose some follow-up problems related to the original problem?  
 

 
 



Handout 10 
 

Constructing a Parallelogram 
 

Student Activity: 
 
1. Write down as many generalizations (theorems, definitions, properties, and 

corollaries) as you can that are related to the parallelogram. 
 

For example: A parallelogram is a quadrilateral, in which each two opposite 
sides are parallel.  
 
(We shall want you to discuss your responses with the rest of the group, so 
please write them on OHP transparency). 
 
 
 
 



2. Think about which of these generalizations can be used to construct a 
parallelogram using Cinderella. Come up with as many different and various 
methods as you can to construct a parallelogram using Cinderella. In each 
construction method, you should: 

 
 List the construction algorithm. 

 
 Explain the theoretical background of the construction algorithm. 

 
 Justify the construction algorithm order.   

 
 
 
 
 
 
 
 



3. How can the different methods of construction be classified? 
 

Classification criteria: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Handout 11 
 

Constructing a Rhombus 
 
Student Activity: 
 
1. Write down as many generalizations (theorems, definitions, properties, and 

corollaries) as you can that are related to the rhombus. 
 

For example: A rhombus is a parallelogram, in which two adjacent sides are 
equal in length.   

 
(We shall want you to discuss your responses with the rest of the group, so 
please write them on OHP transparency). 

 
 
 
 
 
 



2. Think about which of these generalizations can be used to construct a 
rhombus using Cinderella. Come up with as many different and various 
methods as you can to construct a rhombus using Cinderella. In each 
construction method, you should: 

 
 List the construction algorithm. 

 
 Explain the theoretical background of the construction algorithm. 

 
 Justify the construction algorithm order. 

 



3. How can the different methods of construction be classified? 
 

Classification criteria: 
 
 
 
 
 
  

 
 
 
 
 
 



Handout 12 
 

Constructing a Rectangle 
 

Student Activity: 
 
1. Write down as many generalizations (theorems, definitions, properties, and 

corollaries) as you can that are related to the rectangle. 
 

For example: A rectangle is a parallelogram with a right angle.  
 
(We shall want you to discuss your responses with the rest of the group, so 
please write them on OHP transparency). 
 
 
 
 



2. Think about which of these generalizations can be used to construct a 
rectangle using Cinderella. Come up with as many different and various 
methods as you can to construct a rectangle using Cinderella. In each 
construction method, you should: 

 
 List the construction algorithm. 

 
 Explain the theoretical background of the construction algorithm. 

 
 Justify the construction algorithm order.   

 
 
 
 



3. How can the different methods of construction be classified? 
 

Classification criteria: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Handout 13 
 

Constructing a Square 
 

Student Activity: 
 
1. Write down as many generalizations (theorems, definitions, properties, and 

corollaries) as you can that are related to the square. 
 

For example: A square is a parallelogram with a right angle and two adjacent 
sides equal in length.  
 
(We shall want you to discuss your responses with the rest of the group, so 
please write them on OHP transparency). 
 
 
 
 



2. Think about which of these generalizations can be used to construct a 
square using Cinderella. Come up with as many different and various 
methods as you can to construct a square using Cinderella. In each 
construction method, you should: 

 
 List the construction algorithm. 

 
 Explain the theoretical background of the construction algorithm. 

 
 Justify the construction algorithm order.   

 
 
 
 



3. How can the different methods of construction be classified? 
 

Classification criteria: 
 
 
 
 
 
 
 
 



Handout 14 
 

Posing Geometric Problems  
 

Student Activity:  
 

 
 
In the figure above, ABCD is a trapezium whose parallel sides are 

! 

AD and 

! 

BC . X is the point where the diagonals intersect. 

! 

DY  is drawn as 

! 

DY  ‖ 

! 

AC  
and cuts 

! 

BC  at Y. 
 
Use different facilities of Cinderella – constructing, dragging, measuring, and 
calculating facilities – to pose as many various and different geometric 
problems as possible, which could be answered either in direct or indirect ways 
based on the given information. 
 
 
 
 



Handout 15 
 

Finding Geometric Relationships 
 

Student Activity:  
 
In the opposite figure, AF = BE, 

! 

FH  
‖

! 

EG‖

! 

BC , and 

! 

GD  ‖

! 

AB. 
 
Use different facilities of Cinderella – 
constructing, dragging, measuring, and 
calculating facilities – to find as many 
various and different geometric 
relationships as possible, which could 
be deduced in direct or indirect ways 
based on the given information. 


